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User’s Guide 
 
 
 
 

Graphical Analysis 3.11 from Vernier Software is a graphing program that allows you to enter data 
into a data table, graph the data, perform graphical analysis on the data, transform the data, and print 
the resulting graph.  Although the program will do many different types of data analysis so that you 
can discover the functional relationship between two variables, this user’s guide assumes that your 
measured data (or transformed data) is related by a linear function and that you want the linear 
function that best fits your data.  
 
 
GENERAL COMMENTS 
Graphical Analysis 3.1 has an extensive HELP menu including an introduction to the program, step-
by-step help for many common tasks, a description of every menu item and a description of every 
dialog box and every type of object used by the program.  You can use the HELP menu to learn more 
about the many diverse features of this graphing program.  In addition to HELP, there are interactive 
tutorials which explain some of the more popular commands of the program and describe the basics of 
curve fitting.  The purpose of this User’s Guide is to focus only on those features of the program that 
you need to analyze experimental data.  You need to know how to enter the data, plot it, transform it to 
a linear relationship (if necessary), and then to fit the final data to a linear function.    
   
 ¿ Installing  Place the Graphical Analysis 3.1 CD in the CD-ROM drive of your computer 

and 
     the let Autorun start the installation process.  If Autorun doesn’t automatically start, 
  Program.  select Settings and Control Panel from the Start button and then double-click 

on the Add/Remove icon on the control panel.  Select Install to start the 
Graphical Analysis 3.1 install program.  The disk also will install Quicktime5, 
but you should skip this install unless you want that program.  

 
 ¿ Computer • Windows 95, 98, 2000, ME, or XP. 
  Requirements. • 133 MHz Pentium process or better. 
   • 16 MB RAM 
   • 10 MB on hard drive 
    
 ¿ Starting From the Program Manager Screen in Windows, double-click on the  
      the Graphical Analysis 3.1 icon. 
  Program 
    
 ¿ Tutorials. To access the tutorials, start the program, click on File on the Menu Bar 

and select  Open... from the drop-down menu. 
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GENERAL OPERATIONS 
¿ The opening screen of Graphical Analysis 3.1, called a page, includes three areas called objects: a 

Table Object, a Text Object (Notes:), and a Graph Object.  Data entered into the data table (Table 
Object) is automatically plotted on the graph (Graph Object).  At the top of the screen is a Menu 
Bar and a toolbar.  You can make an object active by clicking it with the mouse.  An active object 
has a set of boxes around its perimeter which can be used to resize the object. 

 
¿ The Menu Bar at the top of the screen has the following menu items:  

[File    Edit    Data    Analyze    Insert    Options    Page    Help]. 
Clicking on any menu item in the Menu Bar brings down a list of options.  To select an option, 
move the mouse pointer to the option you want and click on it.  Clicking a 2nd time on a menu 
item removes the list of options.  

 
¿ Very often there is a shortcut to a menu option when you right click on a heading in the Table 

Object or on a label or number on the Graph Object.  
 
 
CLEARING OLD DATA AND STARTING A NEW GRAPH   
Because each part of the screen (i.e. the objects) is controlled separately, clearing the old data does not 
give you a clean slate to begin a new graph.  To start with a new page, click on File on the Menu Bar 
and select New.  Click on No to refuse to save the old graph and data. 
 
 
ENTERING AND PLOTTING NEW DATA  
Graphical Analysis automatically plots each data point as it is entered.  You can enter data two ways. 
 
1. Click on cell 1 under the x column, type in the first x-data and press Enter or Right Arrow to enter 

it.  Type in the  first y-data and press Enter or Right Arrow to enter it.  Continue in this manner 
until all data are entered.  After each data pair is entered, the corresponding data point is 
automatically plotted.   

    OR 
 

2. Type in the first x-data, press Down Arrow, type in the second x-data, press Down Arrow, and 
continue down the column until all x-data is entered.  Use the Arrow Keys to move the cursor to 
the top of the y column and type in the y-data in the same manner using Down Arrow. As each data 
pair is completed, the corresponding data point is automatically plotted. 

 
 
TO EDIT DATA POINTS   
1. To change a data entry.  Activate the data table.  Move the cursor to the cell to be modified by 

either clicking on the cell with the mouse or using the Arrow Keys, type in the new value and press 
Enter.   

 
2. To delete a data pair.  Move the cursor to the row number to the left of the data pair you wish to 

delete and click to highlight the row.  Press Delete .  The data pair is removed and the data below 
this row is moved up.  
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COLUMN HEADINGS IN THE DATA TABLE 
Add column heading to your data table by either double-clicking the label at the top of a data column 
or by selecting Column Options  from Data on the Menu Bar.  Enter a new label with units in the 
dialog box and click OK.  You have to do each column separately.  Note that these labels automatically 
become the labels for the x and y axes of the graph.  Column Options  is also used to set the precision 
of the displayed number in the data table.  Click on the Options tab in the Column Options dialog box 
and set the precision. 
 
MAKING THE GRAPH LOOK GOOD 
Even though the graph is automatically plotted, there are several things you can do to make the graph 
more attractive.  You can add a title to the graph, remove the connecting lines between data points and 
adjust the scale of each axis. 
 
¿ To make changes on a graph, there are at least three ways to access Graph Options .  The easiest 

is to double-click anywhere in the graph area.  You can also right click on the graph and select 
Graph Options... or select Graph Options... from Options on the Menu Bar.  The Graph 
Options tab allows you to title the graph and to remove the line connecting points.  The Options 
tab allows you to scale each axis.  

 
1. Give the graph a title.  Bring up Graph Options as described above and enter a title in the title box. 
 
2. Remove the connecting line between points.  The connecting line between adjacent points is a 

useful tool to see the general trend of a plotted graph, but usually you will want to get rid of it 
before doing a linear regression analysis on your data.  Graphical Analysis 3.1 automatically draws 
these lines as data points are plotted.  To remove the lines, bring up Graph Options  as described 
above and you will see a toggle box labeled Connect Lines under Appearance.  A check mark in 
front of the label indicates that it is ON.  Selecting this option toggles it ON or OFF.  To remove the 
connecting lines, toggle this option OFF. 

 
3. Adjust the Scale of Each Axis.  Bring up Graph Options  as described above and click on the Axis 

Options tab.  Ignore the Y-axis Label, click on the menu button under Scaling: and select Manual.  
Then enter the minimum and maximum values for the Y-axis (called Bottom and Top). A similar 
procedure will change the scale on the X-axis (called Left and Right).  There are two other ways to 
change the scale of each axis.  

  
a)  Move the cursor until it points at the Y-axis label and click.  This brings up the Y-Axis 

Options box which allows you to change the Scaling.  Moving the cursor until it points at the 
X-axis label and clicking will bring up the X-Axis Options box.  

 
  b) Move the cursor over the first (or last) number on the scale.  You will see the cursor become 

an “I” bar.  Clicking the “I” bar highlights the number and you can change it to a new value.  
When you press Enter, the axis will automatically change to the new value. 

 
4. To Remove or Add Cursor Position.  You may have noticed that when the graph is activated, the 

current position of the cursor is shown at the bottom left of the graph.  To turn this feature ON or 
Off bring up Graph Options  and check or un-check the box called Mouse Position and Delta in 
Examine:list. 
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5. To change the symbol for plotted points.  The symbols (circles, small squares, triangles, etc.) 
which surround each plotted point are called “point protectors”.  To change the shape of the symbol, 
you must bring up Column Options .  At this point, the easiest way to get Column Options , is to 
right click anywhere on the graph area.  Place the cursor on Column Options  and select the y-axis 
label (the plotting symbol is associated with the y-axis variable).  Select the Options tab and you 
will find a large menu of plotting symbols under Point Protector Styles.   

 
Another way to bring up the Y-axis Column Options box is to double click on the y-axis heading in 
the Table Object or to select the Y-axis from Column Options  under Data on the Menu Bar. 

 
6. To remove the point protectors.  On some occasions, you may wish to remove the point 

protectors.  Each data point then appears as a small point as if it were plotted with a sharp pencil.  
To remove the point protectors, bring up Graph Options as described above, and you will see a 
toggle box for Point Protectors under the Appearance column.  A check mark in the box indicates 
that it is ON.  Selecting this option toggles it ON or OFF.  To remove the point protectors, toggle 
this option OFF. 

 
 
DATA TRANSFORMATIONS AND PLOTTING TRANSFORMED DATA.   
One of the useful features of Graphical Analysis 3.1 is the ability to plot graphs of transformed data. 
 
1. Create a New Column.  To create a new data column of transformed data, click on Data on the 

Menu Bar and select New Calculated Column.   The New Calculated Column dialog box appears.  
Select the Column Definition tab.  Enter the name and units for the new column and then move to 
the Equation box.  Enter the formula for the data transformation in the Equation box.  As you enter 
the formula, you can choose various functions (i.e. sin, tan, ln, etc.) from the Functions box.  To use 
data from another column in the transformation formula, click on the button next to the Variables 
(Columns) box and select the required data column.  The name of the column will appear in quotes 
in the formula.  For example, to create a data column for the square of time where time data is an 
original column, you would select time from the Variables (Columns) box and then enter ^2  (which 
means raise to the power 2).  The result in the Equation box would look like  “time”^2 .  The 
multiplication symbol is *.  

 
The Options dialog tab in the New Calculated Column dialog box allows you to change the 
precision of the calculated numbers in the new column.  When the formula is correct, select OK and 
the transformed data is computed and placed in the new column.  Note that the new column appears 
in the Table Object and a slider appears below the table to allow you to view the various columns.  
The new data is not automatically plotted.  You must instruct the program what data to plot as 
described below.  

 
2. To Delete a Column.  If you make an error or no longer need a data column, delete it by selecting 

Delete Column from Data on the Menu Bar. 
 
3. Plot the New Data - X-axis.  To choose which data is plotted on the x-axis of the graph, move the 

cursor to point at the x-axis label and click.  This brings up the X-Axis Options box.  Click on the 
button next to the X-Axis window and select what column to plot on the x-axis.  Using the mouse, 
click on the column you want to plot on the x-axis.  Only one column at a time can be plotted on the 
x-axis. Before leaving the X-Axis Options  box, change Scaling: to Automatic so that the new data 
will plot on your graph. 
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4. Plot the New Data - Y-axis.   To choose which data is plotted on the y-axis of the graph, point at 
the y-axis label on the graph and click to bring up the Y-Axis Options box.  Select the column you 
wish to plot on the y-axis.  You can also change the scale of the y-axis on this menu.  Note that you 
several  y columns can be checked thus displaying several graphs on the same y-axis.  When this 
occurs, the y-axis label shows the name of all the selected columns.   

 
 
LINEAR REGRESSION - Find The Linear Function That Best Fits Your Data. 
1. Find the Regression Function.  To bring up the Curve Fitting box either click on the last (far right) 

icon on the Tool Bar or click on Analyze  on the Menu Bar and select Curve Fit...  A Curve Fitting 
box appears which shows a small graph of your data and a menu of possible functions that can be 
used to fit the data us ing regression analysis.  Select (Linear) from the menu and click Try Fit.  The 
regression function is plotted on the small graph and its coefficients appear in a table on the right 
side of the box.  Note that without leaving the Curve Fitting box, you can try any of the possible 
regression functions and immediately see the results on the small graph.  When you are happy with 
the function, select OK. 

  
2. To Change the Position and Format of the Regression Function Box.  After selecting OK in the 

Curve Fitting box, the program returns to show the regression function  plotted on top of the data.  
This regression graph includes a floating box with the function, its slope, y- intercept, and some 
statistics.   

 
 ¿ You can click on the regression function box and drag it (hold the mouse key down) to any 

convenient position.   
 
 ¿ To make changes in the regression function box, move the cursor into the box and double-

click to bring up the Curve Fit Options box.  You can turn off the statistics (recommended) 
and set the precision of the numerical results of the regression analysis (4 significant figures 
for most applications).  

 
3. To Delete the Regression Function Box.  To delete the regression function box and the curve fit 

information, click on the tiny box in the upper-right corner of the floating box or, alternatively, right 
click on the box and select Delete  from the menu that appears. 

 
4. Exploring the Regression Function.  You can display the values of the regression function by 

clicking on Analyze  on the Menu Bar and selecting Interpolate.  When Interpolate is ON, a small 
Examine Helper window appears at the upper left of the graph and displays the coordinates of the 
function as the cursor is moved back and forth along the graph.  The number of significant figures 
displayed for the x-axis value is set by the Columns Option dialog box (right click on the graph and 
select the x-axis label).  Select the Options tab and set the required significant figures under  
Displayed Precision.  The number of significant figures displayed for the y-axis value is set by the 
number of significant figures used in the regression analysis.    

  
 
PRINTING THE GRAPH 
To print only the graph (recommended), select Print Graph... from the File menu on the Menu Bar.  
Other print options including the Print icon on the tool bar prints part of the data table and a smaller 
graph. 
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TO QUIT 
After printing your graph, exit the program by either selecting Exit from File on the Menu Bar or click 
on the X at the upper right of the screen.  In either case, select No in the Save Data? box.  Please do 
not save your work on a classroom computer. 
 
OTHER FEATURES OF GRAPHICAL ANALYSIS 3.1  
The following sections describe some other features of Graphical Analysis 3.1 that you may find 
useful including how to display two plots on a graph, how to plot and examine a function, and how to 
transfer data from lists in a TI-83 graphing calculator to Graphical Analysis 3.1. 
 
DISPLAYING TWO OR MORE PLOTS ON THE SAME GRAPH 
The ability to display several plots on the same graph is useful when you want to compare the shape of 
several  functions with each other.  Graphical Analysis 3.1 will plot several y-columns on the same x-
axis and it will plot two different data sets on the same graph.  
 
A.  Plotting Several Y-Columns on the Same X-axis. 
This situation can occur when you have two or more y-data columns (i.e. a position column and a 
velocity column or a y-data column and a transformed y-data column) and you want to see both plots 
on the same graph. 
 
1. Click on the y-axis label on the graph.  This brings up the Y-Axis Options box, which allows you to 

chose what y-columns you wish to plot.  All the columns will be plotted on the same x-axis.  Note 
that the x-axis column is one of the choices.  Selecting the x-axis column just plots x vs x as one of 
the graphs (not very useful).  

 
2. When you have two or more plots on your graph, you can add a small legend to your graph to 

identify each plot.  To add a legend, right click on the graph and select Graph Options.   Legend is 
a toggle option under the Examine: column on the Graph Options tab box.  When the Legend box is 
checked, this option is ON.  

 
B.  Plotting Two or More Data Sets on the Same Graph. 
1. To create a new data set, click on Data on the Menu Bar and select New Data Set.  The new data 

table (Data Set 2) will appear to the right of the present table and a slider bar appears below the 
table to allow you to bring either data set into view. 

 
2. Enter the new data into the x and y columns of Data Set 2.  Name the columns and add units if you 

wish.   
 
3. To choose how the data is plotted on the graph, click on the y-axis label on the graph to bring up the 

Y-Axis Options box.  The program will graph all the data sets that have a small - sign in the box at 
the left of the data set name.  Click on the small + sign next to Data Set 2 and then check the Y box.  
Click OK and both data sets will be plotted.  When both sets are plotted, the scale of the x-axis is 
automatically adjusted to accommodate both data sets. 
 

4. To add a legend, right click on the graph and select Graph Options.   Legend is a toggle option 
under the Examine: column on the Graph Options tab box.  When the Legend box is checked, this 
option is ON.  
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PLOTTING A FUNCTION 
Graphical Analysis 3.1 can also plot functions, y = f(x).  However, function plotting is not automatic.  
You must enter into the X-column whatever range of values for x that you wish to see plotted.  Then 
these values are used to compute the corresponding values of y using y=f(x) in a calculated column, 
and then plot the resulting columns as described below.   
 
1. Create a Column of X-Values.  Bring up the x-axis Column Options dialog box by either double-

clicking on the x-axis label at the top of the data table, or selecting the x-axis Column Options from 
the Data menu on the Menu Bar, or right clicking on the graph and selecting the x-axis Column 
Options  from the menu that appears.  On the right side of the Column Definition tab page is a 
toggle box called Generate Column.  Check this box and set the range for the x-axis values of your 
function.  The increment should be small enough to obtain a smooth looking plot (keep in mind that 
the program only plots those points that you place in the column).  For example, if you wish to plot 
a function from 1 to 10, an increment of 0.1 would plot 100 points in the chosen range resulting in a 
smooth looking graph.     

 
2. Calculate the Y-Values.  Click on Data on the Menu Bar, select New Calculated Column  and 

enter the name and units for the new column.  Enter the formula for the function in the Equation: 
line using your x-value column as the independent variable.  To enter the x-column in your formula, 
click on the Variables (Columns) button and select the x-axis variable.  The column name will 
appear in quotes in the formula.  For example, to create a y data column for the function y = 2 * 
(sin(x))2, you would enter “2*(sin(“X”))^2 in the New Columns Formula box where the expression 
“X” would be entered from the Variables (Columns) menu.  When the formula is correct, select OK 
and the y-values of the function are computed and placed in the column.   

 
3. Plot the function.  To select which data is plotted on the y-axis of the graph, click on the y-axis 

label on the graph to bring up the Y-Axis Options menu.  Check the box next to the y-column you 
wish to plot and un-check the columns that you don’t want to plot.  You can also change the scale of 
the y-axis on this menu.  Note that more than one y column can be checked, thus displaying several 
graphs on the same axis.  When more than one y-column is plotted, the y-axis label shows the 
names of each column.  Note that the program allows only one x-column to be selected and plotted. 

 
4. Exploring the function.  You can display the values of the function by clicking on Analyze  on the 

Menu Bar and selecting Interpolate.  When Interpolate is ON, a small Examine Helper window 
appears at the upper left of the graph and displays the coordinates of the function as the cursor is 
moved back and forth along the graph.  The number of significant figures displayed for the x-axis 
value is set by the Columns Option dialog box (right click on the graph and select the x-axis label).  
Select the Options tab and set the required significant figures under Displayed Precision.  The 
number of significant figures displayed for the y-axis value is set using the same procedure using 
the Columns Option dialog box for the y-axis column. 

 
You can display the slope of the function at each point by selecting Tangent from Analyze  on the 
Menu Bar.  The slope of the tangent line at each point is displayed as the cursor is moved back and 
forth along the graph.  
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IMPORTING DATA FROM THE TI-83 GRAPHING CALCULATOR 
To import data from a TI-83 calculator, the computer must have a TI-Graph Link cable.  This cable 
connects the TI calculator to the serial port of the computer.  These instructions assume that you want 
to import x-data and y-data from two Lists on your TI calculator.  You must know the names of the 
Lists (i.e. L1, L2, etc.) that you want to send to Graphical Analysis 3.1.   
 
1. Connect the TI-Graph Link cable to the calculator.  Create a new blank data table.  Click on File 

on the Menu Bar and select Import from TI Device... which bring up the Import From Device 
dialog box.  

 
2. Select the COM port to which the cable is connected.  Select the color of the cable and then click on 

Scan for Device.  If the program finds the calculator, it provides a list of the data files in the 
calculator and shows the message “Ready to Import”.   

 
3. Click on the data lists you want to import.  The data will appear in columns in the data table.  Then 

you can name the columns, add units, and plot and analyze the data as described in this User’s 
Manual.   

   
 
  
  
 
   

 


